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A B S T R A C T 

 

This paper evaluates the variation and relationship of Brazilian tensile strength and fracture characteristics of sandstone under different 
weathering grades. Brazilian tensile strength experiments were performed on Fresh and slightly weathered sandstone specimens using an 
automated compression measuring machine UTC-5431. Image-based fracture characterization was carried out using public domain open-
source software ImageJ. Furthermore, SPSS and Microsoft Excel were used to analyze the relationship between Brazilian tensile strength and 
fracture characteristics. Results demonstrate that sandstone tensile strength decreases as fracture maximum deviation distance (FMDD), 
fracture deviation area (FDA) and fracture length (FL), and weathering grades increase. Additionally, FMDD, FDA, and FL  increase with an 
increase in weathering grade. The correlation results revealed that the tensile strength of fresh sandstone has a strong relationship with FMDD, 
FDA, and FL. Whereas, in the case of slightly weathered sandstone, BTS has a strong correlation with FMDD and FDA. Whereas multiple 
regression analysis shows that BTS has a strong relationship with fracture characteristics. Therefore, estimating the fracture characteristics of 
sandstone using its tensile strength is convenient, however, the sensitivity of sandstone strength properties and fracture characteristics to 
weathering must be acknowledged. 
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 1ntroduction 

Rock fracture propagation mechanism is an attractive research area 
with potential application in the geotechnical field (Erarslan 2016, Liu 
et al. 2020). Mechanical properties, especially tensile strength, should be 
accurately calculated to assess fracture behavior in rock. (Shi et al. 2020). 
It is also undeniable that a thorough understanding of mechanical 
responses and fracture behavior is a core component of rock mechanics. 
(Grechka et al. 2006, Lee et al. 2018, Shah et al. 2020). This complete 
insight may also be more obvious after evaluating the link between 
tensile strength and fracture characteristics (fracture maximum 
deviation distance, fracture deviation area, fracture angle, and fracture 
length). The fracture deviation area includes the area surrounded by the 
main fracture and the loading line. Based on the literature, fracture 
maximum deviation distance refer to the maximum distance between 
the fracture traces and the diametrical center (Feng et al. 2020). 
Researchers observed that fracture characteristics have a profound 
effect on weathering-induced fracture propagation (Lei et al. 2015, Kang 
et al. 2019, Koohbor et al. 2019). During weathering, fractures are a major 
infiltration channel that greatly affects the road cut slope (Jiao et al. 
2005, Hencher 2010, Regmi et al. 2013). Fracture plays a crucial role in 
slope water penetration and migration, while significantly decreases the 
stability of the rock slope (Agam et al. 2016, Jaques et al. 2020, Shah et 
al. 2020, Zhang et al. 2020). Fracture characteristics anisotropy is thus a 
well-known phenomenon in rock mechanics, however, its effect on the 

geotechnical structure is frequently neglected (Zhao et al. 2020). 
Therefore, knowledge regarding fracture characteristics and their 
relationship with strength properties is crucial. 

According to Whittaker et al. (1992), rock fracture behavior can be 
analyzed by linking fracture parameters to index test outcomes. 
Whereas, Bhagat (1985) experimentally analyzes that rock fracture 
toughness exhibit positive relation with tensile strength. Additionally, 
Zhang (2002) analyzed the available data in the literature to assess the 
general relationship between Mode-I fracture toughness and tensile 
strength. The author proposed an empirical relationship (σt = 6.88KIC) 
between tensile strength and Mode-I fracture toughness for both soft 
and hard rocks (Bhagat 1985). Similarly, Wang et al. (2007) determined 
a relationship between fracture toughness and tensile strength of clay 
and developed an empirical relationship ( KIC=0.3546σt ). The past 
decades have seen rapid development in fracture mechanics, where the 
research is mainly focused on the relationship between fracture 
toughness and tensile strength. However, the relationship of fracture 
characteristics with tensile strength deserves the same attention since 
the final property of geotechnical structures is dependent on fracture 
behavior. As a result, Li and Li (2015) evaluated the relationship 
between fracture surface area and tensile strength of cement paste with 
various supplementary materials. They revealed that the fracture area of 
cement paste increases with a decrease in tensile strength and proposed 
that polynomial is the best-fitted model ( σt=- 3070 a2+ 27261 
a2- 80234 a + 80367). 

Several studies are dealing with evaluating the effect of loading rate 
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on the fracture characteristics of rock material Zhou et al. (2010), Feng 
et al. (2020), and Bažant et al. (1993). Nevertheless, there is a lack of 
information on how different weathering grades affect fracture 
characteristics and how they interact with one another and with BTS. 
This research advances in understanding the compression fracture 
problem, linking this phenomenon to fracture mechanics induced by 
tensile loading. Tension fracture induced by compression is the 
prominent root of fracture genesis. Therefore, by incorporating the 
FMDD, FDA, FA, and FD, a new relationship has been established 
between Brazilian tensile strength and fracture characteristics. This 
study also investigated the sensitivity of weathering-related tensile 
strength and fracture characteristics correlation. 

 Material and methods 

2.1. Brazilian tensile strength measurement 

The material tensile strength can be measured either directly or 
indirectly, however rock tensile strength is often estimated indirectly. 
The indirect approach (Brazilian test) appears to be the only method for 
which specimen preparation is not rigorous and experimental data 
analysis is quite simple. Consequently, in this study, the Brazilian tensile 
strength test method was used to determine the tensile strength of 
sandstone considering the weathering grades. The sandstone samples 
studied in this research were collected from Sor-Range coal mines area 
Quetta, Pakistan. The area is an active site for underground coal mines 
and the coal bed is roofed with sandstone up to the outcrop. A haul road 
is constructed to access each mine by cutting the sandstone in the area. 
The fresh sandstone samples were acquired from an underground mine 
while slightly weathered sandstone samples were collected from the 
outcrop. The fresh sandstone was dark grey in appearance and the 
slightly weathered sandstone exhibited the brown color shown in 
Figure1. The weathering grade was analyzed visually similar to the 
methodology described in International Organization for 
Standardization (ISO) 14689-1 (2003) and British Standards (BS) 5930 
(1981) (BS 1981, BSI 2004, Tating 2015).  

 

 

 

Figure 1. Procedure of sample preparation for the Brazilian test 
 

Block samples are cut by hand from the exposed sandstone according 
to weathering grade. All the samples were preserved according to the 
methodology described by BS 5830:1999 (+A2:2010) (BSI 2010). The 
sandstone cores with a diameter of 54 mm and with dif ferent 
thicknesses were obtained using a diamond core drill and further cut 
into Brazilian disk samples of 27 mm, 28 mm, and 29 mm 
(thickness/diameter ratio of 0.5 to 0.6) thickness respectively. The 
specimens were categorized into two group’s fresh and slightly 
weathered specimens. Considering the weathering grade of sandstone’s 
Brazilian tests were employed using the UTC-5431 automatic 
compression testing machine shown in Figure 1. 

2.2. Image-based fracture characterization  

A close-range camera was used to obtain experimental testing video 
that was further transformed into frames to capture the fracture 
propagation images. Fracture characteristics (see Figure 2) such as 
FMDD, FDA, FA, and FL are analyzed from a digital image using a 
manual method. Images are reported with fractures that have clear and 
observable boundaries. An open architecture program ImageJ was used 
to analyze and process the captured images. ImageJ is a public domain 
open-source software based on Java 1.5 and a lateral virtual machine. In 
the initial step image file was uploaded to a new window using 
File>Open, File>Import, and Drag & Drop. Followed by spatial 
calibrations that include calibrating a single-pixel image dimension to 
defined values. By using the line "selection tool” a line over a known 
length scale bar was drawn, followed by "set scale" from the "analyze" 
menu. The "known distance" dialog box was entered into the "Global" 
checkbox to add spatial calibration to all open picture windows. A 
similar technique was extended to digital camera photos. For image 
processing algorithms, a binary image (black and white) was generated 
using the dialog tool "Image>Adjust>Threshold" In binary images, while 
the backdrop is white, objects are called black. In proper thresholding, 
the images were translated to 8-bit, 82 grey levels. Afterward, binary 
images and manually traced fractures were created of distinguishable 
boundaries. Measurement of fracture characteristics using the ImageJ 
dialog box "set measurement" Macro fracture research was performed to 
determine macro fracture involvement. The SPSS and Microsoft Excel 
is a comprehensive set of analysis tools that were used for regression 
analysis to evaluate the relationship between fracture characteristics and 
BTS.  

 

Figure 2: Diagram of fracture maximum deviation distance, fracture deviation 
area, fracture angle. 

 Results and analysis 

3.1. Analysis of Brazilian tensile strength 

Indirect tensile tests were performed to evaluate the variability in 
Brazilian tensile strength of different weathering grades sandstone. 
Table 1, displays the sandstone tensile strength and fracture 
characteristics obtained during this analysis. It has been proven that the 
tensile strength of rock material decreases with increasing weathering 
grade (Jaques et al. 2020). When analyzing Table 1 the difference 
between the highest and lowest strength value according to weathering 
grade is 2.071 MPa and 2.99 MPa. Therefore, sandstone exhibit a 
moderate impact on mechanical behavior between fresh and slightly 
weathering sandstone. This may be because physical and chemical 
weathering did not induce significant mineral alteration that could 
explain the loss of material strength. In sandstone, the difference in 
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FMDD is pounced concerning weathering grade. The FMDD in fresh 
sandstone revealed the largest value of 14.52 mm. However, the FMDD 
maximum value for the slightly weathered sandstone is 11.23mm, 
indicating that it is lower than the value for fresh sandstone.  

Moreover, FDA exhibits almost similar behavior in both fresh and 
slightly weathered sandstone with an average value of 141.344 mm2 and 
160.694 mm2. The results also revealed that FDA might have  
 

 

correspondence with the FMDD. The value of the fracture angle 
demonstrates no significant changes at the following degree of 
weathering, although the fracture length in fresh samples is lower 
relative to that of slightly weathered sandstone. This could be due to the 
progressive alteration of microstructures with an increment of 
weathering grade. Consequently, the sample exhibits fracture branches 
along with the main fracture with an increased weathering grade.  

 

Table 1. Brazilian Tensile Strength and Fracture Characteristics of Sandstone. 

 

 

 

 

 

 

 

 

3.2. Fracture characteristics analysis 

The damage mechanism in fresh and slightly weathered rock can be 
characterized by fracture shape, type, and length. In rock, when stress 
gains the peak strength of a typical specimen, the specimen fails by 
exhibiting brittle fractures. The findings showed that the fractures are 
almost straight in fresh rock and approximately pass along loading axis, 
reaching all loading ends except in specimen F-6. The loading rate and 
specimen thickness have a slight effect on the shape of the fracture in 
fresh rock, almost all specimens’ exhibit tip-to-tip brittle fracture. The 
fracture in slightly weathered rock also deviates from the central loading 
line and exhibits multiple fracture patterns (See Figure 3).  

 
 

 

 
Figure 3. Crack propagation pattern in fresh and slightly weathered sandstone 

under various loading rates and specimen thickness. 
 

The fracture produced in specimen F-50 starts at the center line and 
deviates from the center and fractures branches are also created at the 
lower portion. In specimen F-51, the fractures move through the 
centerline; therefore, this calculated strength represents the tensile 
strength of the rock. The fractures propagation in specimens F-6 and 
SW-53 substantially does not follow the central line, therefore the 
calculated strength represents strength characterization for the 
Brazilian test.                                              

When the strength reaches its peak value, the slightly weathered 
specimen under loading does not fail instantly but degrades as a whole. 
During fracture propagation, the main tip-to-tip crack is accompanied 
by numerous small fractures through the specimen.  After the post-peak 
stage of the specimen, the crack that is the main deformation area is 
moderately induced and the main crack is provided with new fracture 
areas and the scale of damage is rising and expanding. It can be seen 
from  

Figure 3, that there are several secondary cracks in specimens SW-52, 
SW-53, and SW-5; these cracks increase in number with an increase in 
weathering grade.  

 Correlation 

The Brazilian tensile strength of rock decreases and fracture length 
increases with increasing weathering grade. A correlation was estimated 
for both fresh and slightly weathered sandstone distinctly to evaluate 
the effect of weathering on the relationship between Brazilian tensile 
strength and fracture characteristics.  

4.1. Fresh sandstone  

The results related to FDA, FMD, and FL indicate that in fresh 
sandstone, the fracture mostly followed the central loading line. The 
fractures, on the other hand, were found to be devoid of branches. The 
correlation coefficient and the regression model were used to determine 
the relationship between tensile strength and fracture characteristics. 
The regression model for each type of variable was evaluated based on 
the R-squared value. The results revealed that there is a moderately 
strong relation (correlation coefficient=0.77) between the variables. The 

Sample name BTS (MPa) FMDD (mm) FDA (mm2) FA (°) FL (mm) 

F6 5.532 14.52 506.47 13.9 50.641 

F8 2.994 0.989 4.548 0 65.397 

F9 7.112 3.65 169.92 7.78 52.859 

F50 4.877 1.35 36.36 3.01 109.782 

F51 3.946 1.437 21.034 0.81 54 

F52 4.55 4.42 130.156 4.88 54.012 

F53 4.928 5.73 120.92 7.114 54.135 

SW 4 0.404 5.016 84.97 0.42 73.966 

SW 5 0.00393 3.53 97.1 11.5 117.767 

SW 6 0.022 5.11 88.35 2.18 54.823 

Sw51 5.041 7.28 236.49 1.48 109.307 

Sw52 2.141 7.31 209.1 9.41 131.309 

Sw53 3.46 11.23 350.48 7.68 135.386 

Sw54 1.622 2.35 58.37 3.23 54.01 
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double reciprocal model is given in Table 2 and Figure 4 is selected as 
the best model based on the correlation coefficient and R-squared 
(60.2%) value. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 4. Scatterplot for the fitted model of various relationships in the fresh 
specimen 

 

The relationship between Brazilian tensile strength and fracture 
deviation area is perfectly fitted to the double reciprocal model with a 
95% confidence interval. For the selected model the correlation 
coefficient=0.89 and R-squared = 79.1%. Regression analysis of BTS*FA 
revealed that Logarithmic-Y square root-X is the fitted model, and the 
ANOVA table indicates that variables exhibit a relatively strong 
relationship with 95% confidence. The selected model is evaluated, 
based on correlation=0.85 and R-squared =72.1%. A similar methodology 
was applied for a relation between indirect tensile strength and fracture 
length and found that squared-Y reciprocal-X is the fitted model. The 

model selection constraints correlation coefficient = 0.27 and R-squared 
=7.23% indicated that there is a relatively weak relationship between 
BTS and FL. Table 2 gives the mathematical representation of the fitted 
model for each type of relationship between indirect tensile strength 
and fracture characteristics of fresh sandstone, while the scatterplot for 
best-fitted models is given in Figure 4. 

4.2. Multiple regression analysis 

In multiple regression, the best-fitted model was determined using 
the ordinary least square approach (OLS). BTS is used as a dependent 
variable, while FMDD, FDA, FL, and FA are used as independent 
variables. Choosing the best model requires several criteria. P-value and 
R-squared were used to select the best model. These values verified the 
regression model. The ANOVA test p-values are acceptable (0.044), and 
the R-squared is 97.8%. Therefore, the P-value and R-square value 
exhibit the accuracy of the regression model, as shown in equation 1. 

 

BTS = 4.7 − 0.7 ∗ FMDD + 0.0073 ∗ FDA + 0.57 ∗ FA − 0.0039 ∗ FL (1) 

4.3. Slightly weathered rock 

The experimental findings showed a comparatively higher fracture 
length in slightly weathered sandstone compared to fresh sandstone 
specimens. The results revealed that there is a strong relationship 
between Brazilian tensile strength and fracture maximum deviation 
area, based on the correlation coefficient of 0.63 and R-squared = 40.2%. 
Based on these constraints linear model was selected as a fitted model. 
Table 3 gives the mathematical representation of the fitted model for 
each type of relationship between indirect tensile strength and fracture 
characteristics of fresh sandstone, while the scatterplot for best-fitted 
models is given in Figure 5.  

The regression model which establishes the relationship between 
BTS and fractures deviation area is squared root-X. The relationship is 
modeled based on R-squared = 59.4% and correlation coefficient = 0.77. 
The results show a relatively strong relationship between the variables. 
In the case of BTS*FA reciprocal-Y logarithmic-X model was adopted, 
but the relationship between variables is weak based on correlation 
coefficient = 0.44 and R-squared = 20.1%. Again, to understand the 
relation between Brazilian tensile strength and fracture length square 
root-X model is selected based on correlation coefficient 0.48 and R-
sqaured-23.2%. The results indicate there is a relatively weak 
relationship between BTS and FL. 

4.4. Multiple regression analysis 

The ordinary least square method was used to obtain the best-fitted 
model in the multiple regression analysis. The BTS value is used as a 
dependent variable, whereas the FMDD, FDA, FL, and FA are used as 
independent variables in the analysis. Some criteria should be 
considered when choosing the optimal model. For selecting the 
optimum model P-value and R-squared values were used. The P-value 
and R-squared value validated the appropriate regression model. The p-
values (ANOVA test) for the models are satisfactory (0.05), and the R-
squared value is 97.3%. As a result, all these statistics proved the accuracy 
of the regression model as shown in equation 2. 

 

BTS = 2.0 − 1.24 ∗ FMDD + 0.045 ∗ FDA − 0.3 ∗ FA + 0.015 ∗ FL (2) 

 Discussion 

This study establishes the context for the relationship between 
Brazilian tensile strength and fracture characteristics in rock. Previously 
few researchers have focused on evaluating this relationship but they are 
limited to other materials, such as Li and Li (2015) analyzing the 
relationship between tensile strength and fracture surface area of 
cement paste under different supplementary materials. However, few 
studies have explored the relationship between fracture toughness, 
tensile strength, and process zone (Jin et al. 2011, Dutler et al. 2018).  
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Table 2. Fitted Model for Various Relationships in Fresh Sandstone Specimen Based on Constraints Selection. 

Variable       Model          Equation Correlation  R-squared 
BTS*FMDD Double reciprocal BTS = 1/(0.16 + 0.133/FMDD)       0.77     60.23% 

BTS*FDA Double reciprocal BTS = 1/(0.18 + 0.69/FDA)       0.89     79.1% 

BTS*FA Logarithmic-Y square root-X BTS = exp(1.18 + 0.18 ∗ sqrt(FA)       0.85     72.1% 

 
 

Table 3. Constraints-Based Fitted Model for Various Relationships in a Slightly Weathered Sandstone Specimen. 

Variable Model            Equation Correlation R-squared 
BTS*FMDD Linear BTS = − 0.64 + 0.41 ∗  FMDD 0.63 40.2% 

BTS*FDA Square root-X BTS = − 2.52 + 0.36 ∗  sqrt (FDA) 0.77 59.4% 

BTS*FA Reciprocal-Y logarithmic-X BTS = 1/(1.58 + 35.7 ∗ ln( FA) 0.44 20.1% 

BTS*FL Square root-X BTS = − 2.96 + 0.49 ∗  sqrt(FL) 0.48 23.2% 

 
 
 

 
 

Figure 5. Scatterplot for a fitted model of various relationships in a slightly weathered sandstone specimen. 

 

In this analysis, Brazilian tensile strength and fracture characteristics 
demonstrated low to a very low association, and further analysis can 
verify the findings provided. 

Additionally, a correlation and regression study was conducted to 
determine the relationship between fracture characteristics. ANOVA 
results indicate that there is a significant relationship between FMDD 
and FDA with a 95% confidence level. Regression analysis reveals that 
R-squared statistics indicate 96.8% double squared model fitting and a 
correlation coefficient of 0.985 show a relatively strong relationship 
between variables. The equation for the fitted model for the relationship 
between FMDD and FDA is given by equation 3 and this relationship is 
also represented by Figure 6. Similarly, the relationship between FMDD 
and FA was evaluated, and the ANOVA results indicate that there is a 
statistically significant link that exists with a 95% confidence level. The 
values of R-squared obtained from regression analysis indicate that the 
double square model is fitted to describe 49.4% of the variability in 
Fracture maximum deviation distance, also correlation coefficient = 
0.70, showing that there is a moderately strong relationship between 

FMDD and FA. The fitted model is represented by equation 4 and  
Figure 6 respectively. The relationship between FMDD and FL is also 

assessed, and the ANOVA table statistics did not show a significant 
relation. Consequently, a weak relationship was observed that was not 
statistically relevant (R-squared = 7.23% and P-value>0.05).  

 
FMDD = sqrt (8.25 + 0.00082 * FDA2)    (3) 
FMDD = sqrt (9.57 + 0.71 * FA2)     (4) 
FDA= exp ( 2.85 + 0.83 * sqrt (FA))     (5) 
 

Moreover, the relationship between fracture deviation area and 
fracture angle is determined and the relation is found to be moderately 
strong. From the regression analysis, the resultant logarithmic-Y and 
square root-X model portray the best relationship between FDA and FA. 
The fitted model is mathematically and graphically represented by 
equation 5 and Figure 6. The fitted model is selected based on R-squared 
(56.2%) and correlation coefficient (0.75). Similarly, the relationship 
between fracture deviation area and fracture length is also determined. 
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The regression study summarizes the fitted model's statistics based on 
the correlation coefficient (0.29) and R-squared (8.66%). The results 
revealed that there is a relatively weak relationship between FDA and 
FL. Regression analysis was performed to appraise the relationship 
between fracture angle and fracture length and the results show that 
there is a weak relation between variables.  

The calculated values were obtained for the coefficient of correlation 
(0.28) and R-squared (8.1%) and the square root-Y squared-X model was 
selected based on these statistics. 

 

 
 

 

 
 

Figure 6. Scatter plot of fitted models among the fracture characteristics 

 Conclusion 

The damage behavior in sandstone includes fracture initiation, 
propagation, and coalescence. Almost all cracks are triggered by 
shearing and tension, while tensile cracks are the ultimate failure of the 

tension test. Therefore, there should be a concrete relationship between 
tensile strength and fracture characteristics. This study has attempted to 
estimate the relation between indirect tensile strength and fracture 
characteristics for both fresh and slightly weathered sandstone based on 
linear regression. The findings obtained allow us to interpret the 
differences, establish a concept and draw the following conclusions. 

1. The fresh sandstone correlation studies show a reasonably strong 
relationship between Brazilian tensile strength and fracture 
characteristics, except fracture length. However, multiple regression 
analysis shows a strong relationship between BTS and fracture 
characteristics.  

2. In slightly weathered sandstone BTS has a relatively strong 
relationship with FMDD and FDA and a weak relationship with FA and 
FL. Conversely, multiple regression analysis reveals a significant 
correlation between BTS and fracture characteristics.  

3. It was concluded that the fracture and strength characterization 
with progressive weathering and their relationship is essential to 
evaluate the impact of weathering on the propagation of fractures and 
mechanical response in sandstone. Among the sandstone properties that 
represent the strength characteristics and fracture behavior was found 
to be the most sensitive to weathering. 
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